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Part 1:  Introduction 
 

EndNote is bibliographic management software which allows you to create your own 

personal database of references - known as an EndNote 'Library'.  

 

EndNote allows you to: 

o Store all the references that you find during your research. They can be exported 

automatically from most databases or entered manually. 

o Store PDF files, images, graphs, tables, etc. 

o Add citations to your work and automatically create correctly formatted reference 

lists in any output style (e.g. APA, Chicago, IEEE, MLA, Vancouver). There are over 

7,000 styles to choose from. 

 

 

Installing the software 
 

The EndNote 21 software is installed on all open-access PCs at Salford.  

 

Our licence allows you to install EndNote on your own device:  

 

o Before you begin the installation make sure all copies of Word, Outlook and 

PowerPoint are closed. 

o Go to the Student Software Portal: https://lssoftware.salford.ac.uk and log in with 

your network username and password. 

o Click on EndNote so that it is highlighted, then scroll down to the bottom of the 

screen and click Next. 

o You will be given a link to install EndNote and a product key. Copy the product key. 

o Click the link, then go to the Select Your Product menu and select EndNote 

o Click the Download EndNote link, then select the EndNote 21  

version you want – Windows or Mac. 

o Follow the EndNote installation instructions (accept all the default settings) and enter 

the product key when prompted. 

 

Staff can request the software through Digital IT’s Service Portal at: 

https://salfordprod.service-now.com/sp  

 

 

Please note that you will only have access to EndNote while you are a registered student 

at Salford, so it is recommended that you make a back-up of your library with EndNote 

Online. This is free and yours for life. Please see pp. 34-35 for more information about 

EndNote Online. 

https://lssoftware.salford.ac.uk/
https://salfordprod.service-now.com/sp
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Part 2:  The EndNote Library 
 

Creating an EndNote Library 
 

Your EndNote Library must be saved to your computer’s local hard drive (C: drive).  

DO NOT SAVE YOUR ENDNOTE LIBRARY TO A CLOUD (e.g. OneDrive, Google Drive).  

IT WILL BREAK. 

 

On some personal computers and laptops the Document folder and Desktop sync 

with OneDrive by default.  

You can check this by clicking the File Explorer icon on your Taskbar. 

 

 

 

If you do not have a Documents folder listed under This PC you will 

need to make one. Depending on the set-up of your device you may 

need to go to Users and create a new Documents folder there.  

This is where you will save your EndNote Library; it’s file path will look 

like this: C:\Users\(username)\Documents 

 

 

To create your EndNote Library: 

o Click the Windows Start button. 

o Scroll down to EndNote into the programs list, then click on the EndNote icon. 

o When EndNote opens, accept the licence agreement, then close the ‘Welcome to 

EndNote’ box (if it appears). 

o Go to the File menu and select New. 

o Save it to the Documents folder on your local hard drive (C: drive). 

 

You should now see two new items in your Documents folder.  

o The .enl file is your EndNote library, and is the file you open. 

o The .Data folder holds supporting information and your saved PDFs. 

These two parts must be saved in the same place. 

 

Note: You should only make ONE EndNote Library. You can save up to 100,000 references 

into an EndNote library, so it will be big enough.  Don’t make separate libraries for 

different assignments, etc. as this may lead to conflicts when you start using it with Word. 

You can make Groups (see pp. 17-19) to organise your references. 

 

You do not need to save your EndNote Library when you have finished working; it saves 

automatically as you add references to it.  
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Importing a Term List for journal titles 
 

This is an optional step, but particularly useful if you are studying any Biosciences, Nursing 

or Health subjects and use databases such as PubMed, which abbreviate journal titles. A 

Journal Term List will give you the flexibility to use either the abbreviated title or the full 

title, as required by the APA 7th style. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 

 

 

 

 

 

 

 

Go to the Library menu and 

select Open Term Lists,  

then Journal Terms List. 

 

Go to the Lists tab  

 

and select Journals,  

 

then click Import List. 

 

Choose the subject list you 

want (Medical is the most 

comprehensive) then click 

Open.  

The list of journal titles 

and their corresponding 

abbreviations will be 

imported into EndNote. 



 

6 

Part 3:  Adding References to Your Library 
 

 

When you use search databases to find journal articles, books and other information it is 

usually possible to import the records you find directly into EndNote. This has the 

advantage of allowing you to import references accurately without having to re-type all 

the information yourself. 

 

Most databases contain a download or export option that will send your search results 

directly to EndNote. If you have your EndNote Library open before you start your records 

will be imported automatically. If your Library is not open EndNote will prompt you to 

open it.  

 

The following instructions are for using Google Chrome as your web browser. 
 

 

 

Saving references from Library Search 
 

 

o Open Google Chrome, go to the Library website: www.salford.ac.uk/library and 

open Library Search. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you have found the record you want to 

save click the quote symbol ” next to it. 

Type in your keywords and click the search icon. 

http://www.salford.ac.uk/library
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The reference you selected will be imported into your EndNote Library. 

Records saved from Library Search and many other databases may need some editing to 

ensure they generate correct APA 7th references. 

 

 

 

If you have saved references for journal articles from Library Search  see the next section 

on Science  

Direct (p. 10) for advice on the edits  

you may need to make. 

 

Records for books from Library  

Search may also need to be edited.  

 

 

 

 

 

Click on the record, so that it is 

highlighted, then click Edit. 

Click Export RIS,  

 

then click DOWNLOAD (you 

might to scroll down to see it). 

Got to your Downloads, 

then click the .ris file to 

open it in EndNote. 
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Saving references from Science Direct 
 

 

o Open Google Chrome, go to the Library website: www.salford.ac.uk/library and 

open Library Search. 

o Click the Database Search link. 

o Type ScienceDirect into the Search box. 

o Click the Online access link. 

o Click the ScienceDirect link. 

 

 

 

 

 
Type in your keywords, then 

click the Search icon. 

Click Edit, then scroll down to the Edition field. 

If the word ed. or edition appears, delete it.  

The number needs to be written as a number, 

e.g. this example should be 2nd or 4th 

Click Save when you have finished making the 

changes. 

http://www.salford.ac.uk/library
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Open the downloaded file as before (see p. 7). 
 

 

When using our other databases look for a link called “Export”, “Download”, “Tools” or 

“Cite”, then choose the “EndNote” or “RIS” option to save references into EndNote.  

 

For further help, see our guide “Downloading References from Databases into EndNote” on 

the Skills EndNote page: 

https://www.salford.ac.uk/skills/referencing-and-plagiarism/endnote-reference-

management-software 

Click the 

checkboxes next 

to the articles 

you want, 

 

then go to the 

Export menu. 

Click Export citation to RIS. 

https://www.salford.ac.uk/skills/referencing-and-plagiarism/endnote-reference-management-software
https://www.salford.ac.uk/skills/referencing-and-plagiarism/endnote-reference-management-software
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Editing references 
 

Records for journal articles saved from Science Direct and other databases may need some 

editing to ensure they generate correct APA 7th references. 

 

 

 

 
 

Scroll down and look at the record: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you have finished making your 

changes, click Save. 

If the DOI has been converted 

into a URL (as in this example), 

cut & paste it into the URL field. 

If there is already a URL there, 

delete it first. 

If it is a DOI (string of characters, 

not hyperlinked) leave it here. 

 

If there is an Article Number 

(instead of a range page numbers) 

in the Pages field, cut & paste it 

into the Article Number field. 

Click the Edit tab. 
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Sometimes you will save references where the title is all in uppercase letters. You will need 

to edit these to create correct references. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remember to replace capital letters for any proper nouns (names of people, places, 

organisations, etc.). Click the Save button when you have finished making your changes. 

Click the Edit tab,  

 

then highlight the title. 

Go to the Edit menu,  

 

select Change Case,  

 

then click Sentence case. 
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Saving records from Google Scholar 
 

o Open Google Chrome and go to http://scholar.google.co.uk/ 

o Enter your search. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Because Google Scholar is a free resource you will not get the same amount of 

information that you would from a subscribed database. You won’t get abstracts or DOIs, 

and often other information, such as volume or page numbers, may be missing. Make 

sure you check your references and add any missing information to the correct fields in 

EndNote. 

Click the EndNote link, then 

open the downloaded file. 

Click the double quote (Cite) ” icon under the reference you want. 
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Making manual references 

 

A few of our databases do not have the option to save references directly into EndNote, 

so you will need to make your own records for them. This is also the case with any material 

you find on the web, such as reports, newspaper articles, government documents, 

webpages, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the Add a new reference icon. 

This will open a blank form for you to 

fill in. 

Select the Reference Type, e.g. Web Page, Newspaper Article, Blog Post. 

Book is a good choice for most reports, standards, etc. 

Fill in the Author, Year, Title and URL fields, and 

Publisher if needed. 

Note: if the author is the name of an organisation (rather 

than a person) type a comma at the end of it. This will 

ensure correct formatting in your citations and reference. 

 

Click Save when you have finished. 
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Importing the full text PDFs 

 

EndNote can locate and import fulltext PDF articles. Select one or more references, a 

group, or your entire library and have EndNote scan for fulltext available to you. When 

the fulltext is found, EndNote downloads it and links it to the appropriate reference 

automatically. For this to work the work must have a DOI, be from a journal the Library 

subscribes to, and be located on a database that allows this to happen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to All References then use Select All 

(Ctrl-A) to highlight all your references. 

Click the Search the Web icon (hover your mouse over 

the icons to find the correct one). 

EndNote will start searching for the full text. 

The paperclip icon indicates that a PDF has been attached.  

To open it, click to highlight the one you want, click the PDF tab. 

Click the Open icon to view the PDF in full screen. 
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Attaching PDFs manually 
 

If EndNote cannot find and attach the PDF for you automatically (see p. 14) you can try 

to find the file yourself, save it, and then attach it to the reference manually. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click to highlight the item you want, click 

Summary, then click the link.  

 

This will return you to the database it 

came from. 

If the PDF is available, download and save it 

somewhere you will be able to find it again – for 

example, your Desktop or Documents folder. 

Make sure you have the correct reference highlighted, 

then click the Edit tab.  

 

Scroll down, click Attach file and browse to where you have the file 

saved. Click on it, then click the Open button.  

Once the PDF is attached, click Save. 
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Annotating PDFs 
 

EndNote allows you to easily view and annotate the PDFs you have attached to your 

references. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Click the PDF tab, then click the 

Open this PDF… icon for a full 

screen view. 

 

To find your notes later click the Advanced search link. Select PDF Notes 

from the menu, type in words you used in your sticky note and click Search. 

Use the Highlight icon if you 

wish to highlight any text. 

Click the Markup/annotation icon 

to start. 

If you would like to write any comments on the PDF click the Sticky note icon, then click 

where you want to write your comment. A balloon will appear.  Double-click on it.  

This will open a box where you can type your comments. 

When you have finished click the cross in the corner to close the comment box. 
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Part 4:  Organising Your References 
 

Creating custom groups 
 

You can create groups as you wish, in order to organise your references. You might wish 

to make groups for each chapter of your dissertation or thesis, or for different 

assignments you are working on. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A box will appear in the Groups 

pane. 

Type in a descriptive name for 

the group you have just made, 

then click the <Enter> key. 

If you are not already there, click All References, so all your references are displayed. 

You can then start filing references in groups by dragging and dropping them from the 

Reference List pane onto the group name. 

Go to the Groups menu 

and select Create Group. 
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Creating smart groups 
 

Smart groups are built with search strategies, for example, works by a particular author or 

matching some subject keywords. Smart groups are dynamically updated as you add 

references to and edit references in the library.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Any references you have in your EndNote library 

which match the search criteria for your Smart Group 

will automatically be filed in the Group, as will any 

future references you add 
 

 

 

Go to the Groups menu and 

select Create Smart Group. 

Type in a descriptive 

name for your group. 

Click the Create button. 

Type in keywords that will match some of your 

references. 

If you wish to search across everything in your library 

select Any Field + PDF with Notes from the menu. 

Use other fields and combinations as you wish. 
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Creating a group set 
 

If you make custom groups and/or smart groups to help you organise your references, 

before long you might end up with a large number of groups. To help you organise your 

groups you can create group sets. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From the Groups menu 

select Create Group Set. 

Give your group set 

a name. 

 

 

Use your mouse to 

drag a group and 

drop it underneath 

the name of the 

group set. 
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Duplicate records 
 

As you add more and more references to your EndNote Library, from a variety of 

databases, it is likely that you will get duplicate records for the same item.  

 

To avoid anomalies in your citations and references once you start adding them to your 

Word document, you need to ensure that you only have one record for each item.  

 

o Go to the Library menu and click Find Duplicates. 

o Any duplicate records will be displayed, with the areas of differing text highlighted.  

o Generally, you should keep the older record, as this is likely to be the one you have 

edited, added attachments to, and most importantly, already used for citations in your 

document. 

 

Note that the criteria used by EndNote to identify duplicate records won’t always catch 

all of them. You will still need to look through your Library and delete any records you 

don’t want. It is probably easiest to do this if you sort your Library by ‘Author’ or ‘Title’. 

Click on the column header to do this. 

You can tell which is the older record by looking 

at its record number (preceded by  #). 

If necessary, you can copy 

& paste information from 

your ‘reject’ record into the 

one you want to keep. 
When you have finished any editing, click 

the Keep This Record button for the one 

you want to keep.  

The other record(s) will be sent to Trash. 
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Part 5: Cite While You Write 
 

You must acknowledge all the words, ideas or research of other authors you have used in 

your own writing. They must be referred to twice: 

 

1. In the body of your text, the author’s name and the date of the work, enclosed in 

parentheses. This is called an In-text Citation 

2. In a reference list (bibliography) at the end of your document. This has full details 

of the publication, such as author(s), title(s), publisher, volume and page numbers. 

This is called a Reference. 

 

Students on most taught programmes (Undergraduate and Masters) at the University of 

Salford must use the APA 7th style.  

 

PhD students should use a style that is appropriate for their subject area. Check with your 

supervisor if you are unsure which style to use. 

 

EndNote works with Word to insert citations into your document and automatically create 

a correctly formatted list of references. This is all done using the “Cite While You Write” 

(CWYW) toolbar, which you will see in Word once you have installed EndNote on your PC. 

 

Inserting citations into a document 
 

 

1. Open your EndNote library. 

2. Open your Word document. To practice you  

might like to use some “play” typing like this:  

 

 

 

 

 
3.  In the document click the place where you wish to place a citation in the text.  

Remember to leave a space between the last character and your cursor, and that your 

citation is placed before any punctuation (a comma or full stop).  
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In EndNote: 

 

 

4.  Click once to highlight 

the reference you want 

to use.  

5.  Click the Insert a Citation icon.  

Not what you were expecting to see?  

EndNote defaults to the ‘Annotated’ referencing style, which includes the 

abstract. To change it go to the Style menu and select APA 7th. 

 

6.  You should now see a citation in your text, and the 

first reference in a list at the end of your document. 
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Direct quotations and page numbers 

 

The APA 7th referencing style requires that a citation for a direct quote must include the 

page number where you found it.  

 

Remember that a direct quote should be placed in “quotation marks”, or indented from 

both margins if it is longer than two or three lines. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.  Insert your citation, then click on 

it, so that it is highlighted. 

2.   Click the Edit & Manage Citation(s) 

button on the CWYW toolbar. 

Check that the 

correct citation 

is highlighted. 

Type the page number(s) in the Pages box. You do not 

need to include p. or pp. – EndNote will do this for you. 

Click the OK button. 

The correctly formatted page number will now be added to the citation: 

(Wu et al., 2023, p. 5) 
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Changing the citation format: narrative citations 

 

 In your writing you will often integrate the author’s name into your text, for example: 

 Ali et al. (2020) described the … 

 

In this case, you do not repeat the authors’ names in a citation at the end of the section.  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

To format your citation this way, place your 

cursor where you want the author’s name to be – 

usually this will be at the start of your 

paraphrase. 

Insert the citation in the usual way. 

Right-click on the citation you have 

just inserted,  

 

go to Edit Citation(s) 

 

and select Display as: Author (Year). 

Your citation will now be correctly 

formatted, i.e. authors’ names 

incorporated into the sentence, and 

followed by the date in parentheses. 
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Adding multiple citations 

 

There will be times when you have summarised the content of two or more different 

papers into a single sentence or paragraph, and will need to insert a multiple citation. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.    In EndNote, hold down the <Ctrl> key while 

you select the references you wish to cite. 

2.    Click the Insert a Citation icon. 

In your document, place your 

cursor where you need to put the 

citation. 

The multiple citations will be inserted in your document in the correct format – all three articles 

are enclosed in one set of parentheses, in alphabetical order and separated by semicolons.  
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Creating secondary citations 
 

There are times that you will find something referenced in a book or an article that is so 

useful or interesting you want to use it in your own writing. This might be a citation for 

another article, or an illustration, graph or table take from another work. 

 

Generally, you should try to find and read the original work and use that as the source of 

your citation and reference. However, there are times when this isn’t possible, for example, 

you may not be able to get hold of the original work, it is in a language you can’t read, or 

the citing author has summed up the ideas in the original more succinctly or elegantly 

than you could ever manage. 

 

When you use a secondary citation like this, your in-text citation should mention both 

works but your bibliography only includes a reference for the work you have actually read 

yourself. You can use the CWYW tools to format a citation in this way. 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For example, you may wish 

to use this idea, attributed 

to Campbell, in an article 

you have read by Drezner. 
 

Insert the citation for the article you have read, then 

click on the citation so that is highlighted then click 

the Edit & Manage Citation(s) button on the toolbar. 

 

This will format the secondary citation and add the correct item to your reference 

list. Remember to add a page number if you have used a direct quote (see p. 23). 

 

Make sure the correct 

citation is highlighted. 

 

In the Prefix field, type in the authors and the year for the 

work you have seen cited plus the words ‘as cited in’. (You 

should check the exact wording required by the style you 

are using.) Leave a space after the last word.  

Click OK. 
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Deleting citations 
 

Because of the large amount of coding behind each citation you insert, you cannot simply 

remove a citation by using the <Delete> key. Nor can you delete a citation you have put 

in the wrong place by using the ‘Undo’ button in Word.  

To remove a citation you must use the CWYW tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Your citation, all its coding, and its matching reference (if this was the only citation for it) 

will now be removed cleanly from your document. 

Click on the citation so it is highlighted, then 

click the Edit & Manage Citations button. 

 

Click the OK button. 

 

Click the arrow on the Edit Reference button 

and select Remove Citation.  

 

This will format the secondary citation and add the correct item to your reference 

list. Remember to add a page number if you have used a direct quote (see p. 23). 
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Putting it all together: merging chapters 
 

When writing a big document such as a dissertation or thesis many people to choose to 

write each chapter as a separate document. If you have been using EndNote for your 

referencing this will mean that each chapter has its own set of in-text citations and its own 

reference list at the end. 

This guide explains how to merge your chapters so you have one complete list of 

references at the end of your dissertation or thesis. 

 

1.   Make copies of your chapters 

 

o Save each chapter with a new name, for example, Chapter 1 Copy, Chapter 2 Copy, 

and so on. This way, you will have your originals to return to if anything goes 

wrong.  

o Save all these copies in same place so you can find them easily. 

 

 

 

 

 

 
 

 

2.   Unformat your citations 
 

 

 

 

 

 Select Convert to Unformatted 

Citations. 

Go to the EndNote 21 tab, then 

click Convert Citations and 

Bibliography. 
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3.   Repeat for all your chapters 

Follow the above instructions to unformat the citations in all your chapters. 

 

4.   Merge the chapters into a new document 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You should notice that the Instant Formatting has 

turned off, your citations now look like this, and 

your reference list has disappeared. This is all good. 

Open a new Word document and make a couple of 

blank pages (CTRL+Enter) so you have somewhere 

for your title page, table of contents etc. 

Note: You might find it easier if you use the Zoom 

tool to make your pages small, like these examples. 
 

Open your Chapter 1 copy document 

(with the unformatted citations) and 

use CTRL+A to highlight all the text. 

Use CTRL+C to copy the text, and 

then use CTRL+V to paste the 

chapter into your blank document. 
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Now repeat these steps to paste Chapter 2 Copy here – remember to use 

the version with unformatted citations. 

Repeat, until all your chapters have been copied into the new document. 

Once all your chapters are merged, click 

Update Citations and Bibliography. 

You will see a status bar showing its progress. 

Depending on how many citations you have, 

this could be quite slow. 

You will now have a single list of all your 

references at the end of your document. 

Don’t forget to SAVE it! 

To continue to add citations, turn 

your Instant Formatting back on. 

However, if you find the updates 

are now very slow, you may wish 

to leave it turned off. 
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Some things that might go wrong 
 

Has your Reference List disappeared? 

And are your citations now in curly brackets with a # number? 

 

Don’t be alarmed.  Your ‘Instant Formatting’ has turned itself off. These are called 

Temporary Citations, and there is more information about them on pp. 29-30. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Is your Reference List in a different font? 

You can change the font to match the rest of your document. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Instant Formatting is Off and 

select Turn Instant Formatting On. 

Your citations should re-format instantly, but if they 

don’t, click Update Citations and Bibliography. 

Click the little arrow in the 

corner of the Bibliography 

section. 

Click the Layout tab, then 

select the font and size you 

need.  (If you are writing a 

dissertation or thesis this will 

usually be Times New Roman, 

12.) 
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Are there initials in your citations? 

 

You may notice that initials, or even given names, are 

appearing in some of your citations.  

 

This is not actually a fault; it is EndNote differentiating 

between ambiguous citations.  

 

You need to be able to tell which citation matches which reference – this is the whole 

point of referencing. 

 

 

 

 

The appearance of initials happens when  

you have works by the same author but with  

their name entered differently,  

 

 

 

 

or you have  

different authors with the same family name. 

 

 

 

 

 

If you don’t need initials to differentiate citations (for example, the works are from 

different years) you can ask EndNote to stop including them. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From the Tools menu go to Output Styles and select Edit “APA 7th”  
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Click the Update Citations and Bibliography button in Word document and the initials 

will be removed.  
 

 

 

  

Note: in this case, the letters a and b have been added to the citation to distinguish between 

works written by the same person in the same year. EndNote does this for you automatically. 
 

Click Ambiguous Citations,  

then click to un-tick the Include the author initials … 

box. 

 

Then click Author Name,  

and click to un-tick the Use initials only … box. 

Go to the File menu and use Save As to save the style with the 

same name (e.g. APA 7th.) 
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Part 6:  EndNote Online 
 

It is recommended that you use EndNote Online to make a back-up of your EndNote 

library. By synchronising your EndNote 21 Library with your Online account your 

references will be backed up every time you open or close your library, and you will be 

able to access them anywhere you have internet access.  

 

Your EndNote Online account is yours for life, which means you will still have access to 

your references after you have left Salford – remember that your access to EndNote 21 

will expire after you have left the University. 

 

 

EndNote Sync 
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Go to the Library menu and click Sync. 

Click the Sign Up button. 

Note: If you already have an EndNote 

Online account you can sign in here. 
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Using EndNote Online 
 

Although the principles of using EndNote Online are the same as using the software 

version, it looks quite different and the processes for saving references into it and using 

the CWYW tools are also different. 

 

EndNote Online training materials, including videos and a PDF guide are available on the 

EndNote website: 

https://clarivate.com/webofsciencegroup/support/endnote-online/  

 
 

Enter your email address, first and last 

names in the boxes provided, and make 

yourself a password following the 

guidelines provided.  

When you have completed this, click the 

Sign up button. 

When you have completed the 

registration process click the Sync 

button. 

This will send your references from 

EndNote 21 to EndNote Online. 

https://clarivate.com/webofsciencegroup/support/endnote-online/
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Part 7:  Getting Help 
 

o More help EndNote can be found on the Skills site:  

https://www.salford.ac.uk/skills/referencing/endnote-reference-management-software 

 

o EndNote provide training resources, such as videos and guides: 

https://clarivate.com/webofsciencegroup/support/endnote/  

     and you can get further support here: 

https://support.clarivate.com/Endnote/  

  

o Further guidance on APA 7th referencing can be found here: 

https://www.salford.ac.uk/skills/referencing/apa-7th-edition 

 

o If you have any enquiries please contact the Academic Support Librarian for your 

subject area. Their details can be from the Choose a subject menu at:  

    http://bit.ly/sflsubject  

https://www.salford.ac.uk/skills/referencing/endnote-reference-management-software
https://clarivate.com/webofsciencegroup/support/endnote/
https://support.clarivate.com/Endnote/
https://www.salford.ac.uk/skills/referencing/apa-7th-edition
http://bit.ly/sflsubject

